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1. HME

1. #=E

AR RF 2 A2 MME S1IC31 Family Xt emWin D5 & 7Ly 7 s OEMEIC DWW TR L TV E
7, emWin |, Segger Microcontroller tE3FF A L CWH 7 77 4 v 7Y 7 vy =7 & GUI (VT 7 47
Na—W—of =Tz A R) BETT,

KR —DIZEEN TV D emWin 1%, S1C31D01 FHICFHEE S CuvE 4,

1.1 EnERE
S1C31D01 TemWin 7'z 77 A& AR L CTHEITT DI, AT ORENLETT,
- S1C31D01 F¥ffi A — K
FHlIAR— ROATFTFIEIZOWTIE, KTV OTT Y =N AE T 4 AZBBWEbELZE N,
N R T TNy A H—T 2 —2A
Segger J-Link Plus 25 #E4E < k4,
- ARM H IAR Embedded Workbench
A —1F IAR Ver.8.32 THER L TV E T,
- ARM A Keil MDK
A%y - —1F MDK Ver5.25 T L TV £,
- S1C31D01 l emWin /8w 77— (A3 5 —3)
ARy r— 0 emWin 1Z Ver.5.48m T,
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2. emWin®ty 7y

2. emWin®Dty b7y

ARETIL, B4 L VIR 2 emWin Xy 7 — D LEHlIAR— RE2FEH LY 7 b =T OENLR -« 5
Ry TIFHEICOWTHBHAL 7,

2.1 emWin /8w H5r— DR

emWin X 7 —20OF 4 L7 M URERIZLAITO L H 12> TnET,

¥SXC31xxx_emWin_ver_x_xx_yymmdd

board MR — R E
L —S5U1C31D01T1
——CMSIS CMSIS (8
Device
Driver
Documentation RESE AV
L——s1C31D01
——emWin emWin V7 o =7
Doc emWin R = A > |
Sample emWin %> 7 L7 a7 Z A
¢31_basic_performance
€31_demol
c31_demo2
c31_demo3
c31_sample
—Start
-Application
Config emWin iXE 7 7 A /L
GUI emWin ~v % —7 7 A JL
Tool emWin > —/ L (GUI-Builder, BmpCvt)
——WORKSPACE emWin UV —27 A ~X— X
L——S1C31D01T1
———LIB emWin 71477
—IAR
——ARM
L USER emwWin +—H%—7U—27 ZA~— 2R
—IAR
—ARM
Licenses FA A
CMSIS
L——emWin
sePeriphLibrary S1C31 LR~ » & —
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2. emWin®Dty h7vF

22 BR—HybrN—FH9z7 tRARBIREOERE

FAFSEREED A A R — /L LRI — R & DBHGRIILL T DO RF 2 A FESRLTHFIVY,
«S1IC31Family Y 7 N =Ty VT v I HA R
- S1C31D01 N> TV 7 vy =T ~=aT )b
- S5U1C31D01 v == 7"/

23 BEOYUIILTITACzH FEEILEFETS

N=R 2TV T N 2T H A AR VL TRELZL, o7y M2 E/LRLT
SIC31D01 iz — R L, Y AT ANIELLSHEREL TV D Z & 2R L T 72 &V, Z 2Tl ¢31_demol
a2l hOENL RIZOWTHHALE7,

231 IAR EWARM
1) emWin V—27 ZAX—Z %<

IAREWARM IDE Z & L, [7 7 A L] [HL]>[V—2 A—R]& 27V v 7 LTEREND T 7
AIGRINZ A 71 7T, emWin /Ny r— U OERE 7 + VERICH DU TO 7 7 A )V ERIL £
‘é—o

¥SXC31xx_emWin_ver_x_xx_yymmdd ¥emWin¥WORKSPACE¥S1C31D01T¥USER¥IAR¥emWin.eww
2) JEAREIA 77V EENLRTD

“sePeriphLibrary” 7m > =2 N7 Vw7 L, [T7 7 4 7ICRE|ZEBRLTCT 77 4 712 LE
TR, TRV s M a2 Y v LCRTABEL RIZRILTEL FLET,

A=V 4 RUD[EN RF TIZET =R 2R L ET,
3) A Tevel hEENLRTS

“c31 demol” Yu Y=l haeHTZ Vv I L, [T27T 4 7IWCREEEBIRLTCT 7T 4 712 LET,
Wiz, 7aY=7 ek 7 ) v 7 LC[ETEHELRIZEIRLCELRLET,

TnYae s FEERLZE, F8 X —%2M LT “Debug-All” Z#ERL T “2TEENLR RF
7 Vw7 L CFrY=Y ML RTLHELDY £,

A=Y U4 RUD[ENRFZ TICET =R e LET,

4) 77 A )% SIC31DOL (Z¥ 7 — K
“Ctrl+D” T, [FrY =l FPp[F v — RLTT Ay ZZERLET,
Fyora— R RRETLEL, FBX—2M LT u s I 5%bGLET,
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2. emWinDty c7v 7

(JF) #1HTSIC31D0L I uy =/ haAurua—RT 5L ROXATalRnNERISNET,

w

The zelected device "ST1C3T0D01" iz unknown ta this version af the J-Link saftware.

Fleaze make sure that at least the core J-Link ghall connect to, is selected.
Proper device selection is required to use the J-Link internal flash loaders
for flagh download or unlimited flazh breakpoints.

For zome devices which require a special handling, selection of the corect device iz important.

X 2.1 MCU REBREELESF 4705

OKRHZ %7 ) w7 L, IRDEAT 17T “Cortex-M0+” ZI&IRL £9°,

Filter - -

 anufacturer Device Core Little endian h

: ™ | | i e Core #0
b anufacturer Device Core MumCores Flazh size Réb gize ™
| Inzpecified ARMS ARMS 1
Unspecified ARMT1 ARMT1 1
| Inzpecified Cortex-45 Cortex-45 1
Unzpecified Cortex-47 Cortex-47 1
| Inzpecified Cortex-48 Cortex-48 1
Unzpecified Cortex-43 Cortex-43 1
| Inzpecified Cortex-812 Cortex-812 1
| Inzpecified Cortex-415 Cortex-415 1
Unzpecified Cortex-817 Cortex-817 1
| Inzpecified Cortex-tv8_Baszeline Cortex-t ARMvEM b... 1
Unzpecified Cortex-MvE_Mainline Cortex-t ARMwEM 1
| Inzpecified Cortex-b0 Cortex-t0 1

Cortex-t0
Cortex-M Cortex-M1 1 - -

Select a device for J-Link.
Selecting a device iz not required for most devices, but alloves more efficient operation of J-Link az well az flazh

download.modification of flazh memory during a debug sezsion ag well as unlimited breakpoints in flazh memory (Flagh

Breakpaints). Cahcel

Ih casze of doubt, select the first entry in the list "Unspecified Device''.

X 2.2 MCUEIRZ4 7045

5) TAAT VAR RINDTEI R I T LT 27 LET,
TYATVADFERE, BIRLEZTETR ST AL TRRY $97,
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2.

emWin Dty b7y F

2.3.2 KEIL MDK-ARM (uVision)

1)

2)

3)

4)

emWin U — 27 AR—Z % BA<

Keil MDK % L #)j L | [Project]> [OpenProject]Z 7 V v 7 L TRRIND 7 7 A WVEIRF A T 0 7 T,
emWin /3 7 — U OFREIE T + VA NIZH DL T O 7 7 A4 VEEIR L ET,

¥SXC31xx_emWin_ver_x_ xx_yymmdd ¥emWin¥WORKSPACE¥S1C31D01T1¥USER¥ARM¥emWin.uvmpw
AR Z A4 77 ) 2 eV RT 5.

“sePeriphLibrary” 7w =2 h&4 27 U > 7 L, [SetasActive Project] #3IR LC7 7 7 ¢4 7IC L&
I, WIZ, 7uy=2 h&AHZ Y v LC[Project]>[Rebuild ‘sePeriphLibrary’] % #4R L CE/L K L
ESc AN

A vt—Tv 4 RUO[BUild Output] ¥ 71Z= T —RN W2 L 2R L £ 7,
o rnTaey e hEELRT S

“c31 demol” v = h&A427 U7 L, [SetasActive Project] # R L CT7 7 7 4 7IZLET,
Wiz, 7uv=2 h&f27 U 27 LTC[Project]>[Rebuild ‘c31_demol’]|Zi&R L CE/L RLET,

A vt—Tv 4 RUO[BUild Output] ¥ 71Z= T —RN e\ 2 L 2R L E7,
7 7 A V% SIC3ID0L IZ¥ v v — R

“Ctrl+F5” % 47>, [Debug]>[Start/Stop Debug Session] % &R L £ 7,
Fyra—RRETLEDL, BBXx—%2#Lra s 7 A%t LET,
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3. S1C31 Family ® emWin §&5€

3. S1C31 Family ® emWin &5

AKE T3 S1C31 Family T emWin Z il 256 ORE T 7 A MOV THA L £T,

TRTO emWin 7 ¥ =2 ML, “config” 7a v = N A—TRNEENRTWET, 2O L—T
Wi, I Ehi=7 ey =7 FEERT D, £ emWin N— R =7 A X —T 2 —ADHHR—
MR ET DT D7 7 A VR EENTOVET,

3.1 LCDConf.c /LCDConf.h

7 7 AL LCDConf.c I%, Fr/ N3 /VORSE, BEBRTGE, BLOERRRIANSNERIN T D507
‘/C‘\‘j—o

311 TFAARTLANRRLEAT

HIIE, LCDConfc i 8 2DT 4 AT VA NRFNL A TINERINTWET, NRNX A T HEINT D
L. RZDTaRT 4 (B, B, BORI) PRE I, @WEUIRASRAYEHL —7  ADREE S
nEJ,

BV R—FENTWERRVILLFD@Y T,

LPMO010R030B -180x180,6 £ b 7—,0.99 1 > F, HIE
LPM012M134B -240x240,6 £ b 7T —,1.19 4 > F, HIE
LPMO014T262C -205x148,6 £ b 7 —,139 1 »F, EFF
LPM027M128A - 400240, SPI, 3 &> " T —, 27 4 > F, BHE
LLS010B7DHO1 -128x128,SPI, 1 £~ ~ BW, 1.0 7 > F, [JE
LS012B7DH02 -240x240,SPI, 1 £~ ~ BW, 1.2 1 > F, HJE
LS013B4DN04 -96x96, SPI, 1 £~ ~ BW, 1.3 1 > F, IEHE
LS013B7DHO06 -128x128,SPI,3 €' N7 —,133 14 ' F, EHE

UARPOARPNVEFRL LOTEITEIRL, 2 XA ML TBEET,

312 BFiE

BIRCX S A FIXLL T Ol Y T9,
COLOR_CONVERSIONGUICC 2222 -6 £ h#F— (RrGgBb) & 2 &'y hT7 V7 7 & AR — b
COLOR_CONVERSIONGUICC 111 -1ty h A F— (/27 1) ZHHR—|

IR A TRV ERICET) L CEBRENETOTERT 208 IH Y 8 A,

313 TFTARTLALAEZAN

TAAT VA RTANNZ ZCTEIRSNET, BEFS T, UTFTO— DO LN ERINLTWVEHEADOTE
FHIAMLEIHD FH A,

GUIDRV_EPSON_C31

3.2 GUIConf.c / GUIConf.h

INHDT7FANTHEHAINDIREICONTIE, emWin D~==2T/LEZBRL T &V,
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3. S1C31 Family M emWin &%

3.3 Epson_C31.c/Epson_C31l.h

—hbD7 7 A%, GUIDRV_EPSON_MCU 78 LCDConf.c TEFRSN TV T, HRREL S £/
AlfERENET,
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4. YFTWI T b7

4. YTV I b9 x7F
AKETIE, emWin X r—JICEENTWEY LY 7 b =T IOV T L £,

4.1 c¢31_demol

OV LTI T ATIE, TXA MEEREY ILOFH. T A arR0F = v 7Ry 7 AD AR
R4y NOFERZRED 2D fiE AR L ET,

4.2 c¢31_demo2

IOV Ta T AL emWin U4 Ve NEFHT A HIEAZRLTWET, BREHOTZOIZ
emWin 7« Y= haWT7 7 T 2T B HEOFIZONWTIE, V—Aa—RFESR LT EE,

4.3 c¢31_demo3

ZOY T ST ME, bin2cexe & bmpevtexe Y — L EFEH L TER SN S EIE /A AV
ERALET,

4.4 ¢c31 basic_performance

IOV T T e s AT emWin Y7L 75 L@ BASIC Performance 7' Y = 7 R ORI T,
FROBEFRET 2HEMms) 2R~ LET,

45 ¢31_sample

oV oI Ta ST NI oo al T XA T “Welcome” ZF <L ET,
7oy 7 FEERTAHAIC. ZORNEOT oY =7 FEfEH LTS ZE0,
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5. S1C31 Family T emWin Z{#Ad 2545 0# 21FH

5. S1C31 Family TemWin 2T 31580+ B15H

ARECIE, RS2 S1IC31 Family T emWin % 3 2 BT SIE WA sk L £,
51 TARTLLADT7YTTF—F

FEANEDT T T 4NV AT AT, FILWT—ENT A AT LA AEVICEZRAEIND ETIZ
TAATVANETHTINET,

S1C31 Family TOEMEIZD LEZR D 9, X7 4 A7 LA AV NNy 7 7 IfTbIvETN, /%L
FH Y — 7 ARG EN D E TAARVETEF SN EE AL

BRIV EEHFTH T RIT 7)) r—y g ARk b, kg iThbiE T,

T —a ROV EHEFIE L TV AT, emWin 28 AE D T, R BT LETH Y
FHA, TAA AL UH T =2— A TLE4 AT Y FEIICHEE L, T X COWmBET LERICT 4 AT
LA ZHH LET, 2L, SIC3LFamily D n— R =7 A v #—7 = — ZARBEIC Y AT MTARE T
5zl

52 2DS4A4 735

emWin 2D 74 77 U1, WOTHLRERHTZ N TEAHEL—F o oaL sy g T, RIS,
T 4 AT LA EHL—TF L seMDC_PanelUpdate () X, 7 4 A7 LA ZHHT H72DITW-DTH RO
FTILENTEET,

TV = a3, NRNVEEHT LA I T EFERICHIE L T D7D, T4 A7 LA RICRE
EIRANEILE SRV E S EE LIRSy (AN AT E S RGN

53 w«a4Pxvh

T4y NI, 22— A U F—T = ADERRE R T DD a s fe— Va7 LT
T2l NeBINTAEDICERINEZT T 74 DNVTATLELATT, U4y MTIE, AEY, Fx v
IRy T A, T—AU 4Ry, 77, VAMRyZ AR EOHEENGENET,

T4y hD1ODOKHIT. WM PAINT A vt —V 2% E L SICHiE+T5 2L T, 13EAL
DYAT LTI, V4V =y MBRHEIND ETICT 4 AT VAR RSN ET, SIC31 Family @
TAAT VAT —=XT 7 F ¥ TlE, V4V =y bEIIMMO GUI L AV MRT 4 AT LA RNy Ty
WCEEAATHLT A AT AT SIEEREINET A,

U4y MR T 4 AT LA ETHEEICEH NS L 912, SIC3L Family HIZE =7 v 7T AL,
HHT 2742y T EICAyE—Y T =2 —IZ#H L, WMPAINT X vE—HO
seMDC_PanelUpdate () ZFFOMHTMLERH D 5,

Tl Il FEAEDT 4V ey DT 4 U R A=Y e N RTEF—N—T 4 LT,
W80 ICHEE 5 BN H D 7,

V4 Yy RBWM_PAINT A vt —U 5% 0L E, UV y MIMEIZS U TEONETH L
F9, WM_PAINT Ok, ¥ A7 5E WM_POST PAINT A vt —T%RITLET,
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5. S1C31 Family T emWin Z{#AY 2545 0# 21FH

F—N—=F A ROERRIZLL T D L D IfT7WVWET,
void aFunction (void)

{
WM_HWIN hCal;

/I Create a calendar.
/I Note the callback for the calendar to the _cbCalendar() routine
hCal = CALENDAR_Create (WM_HBKWIN, 0, 0, 2016, 11, 30, 1, ID_CALENDAR, 0) ;

WM _SetCallback (hCal, _cbCalendar) ;

/I Show the calendar, pause, then delete the calendar
WM _ InvalidateWindow (hCal) ;

GUI_Delay (5000) ;
WM _DeleteWindow (hCal) ;

NV —=a— RNy I —F U NETRTORA =% T T7ANV DAV F—a— oy 7
L. Ay &= WM_POST_PAINT DG 13/ RV EFH/V—F U SFFO SV E 5,

1l

/[ _cbCalendar

/[ The common dialogs handle most message internally. However updating the

/I display requires a panel update sequence and that is where this routine

/I comes in.

1l

/I _cbCalendar connects to the CALENDAR message chain and adds functionality to
/I the WM_POST_PAINT message. All other messages are processed by the default
/I calendar handler.

1l

static void _cbhCalendar (WM_MESSAGE * pMsg)
{

GUI_RECT invalidRect;

CALENDAR_Callback (pMsg) ;

/I WM_POST_PAINT is sent after WM_PAINT completes.
/[ This is an excellent time to update the panel.
if (pMsg-> Msgld == WM_POST_PAINT) {

WM_GetlInvalidRect (pMsg-> hWin, &invalidRect) ;
seMDC_PanelUpdate (invalidRect.y0, invalidRect.yl) ;

S1C31 Family emWin
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5. S1C31 Family T emWin Z{#Ad 2545 0# 21FH

FERICL T DT RTOY 4 V= NOBFKEEZ A —N—T7 A4 FLET, 774V DT 4 Pz
k=—/ L3y 7%, WIDGETNAME_Callback &\ 5 ERiZ72 0 9, L7=A-> T, MULTIEDIT ¥ «
Vv hTIEFT 74/ hD 3 —/L 3y 71X MULTIEDIT Callback () <. TREEVIEW 7 ¢ ¥ = v b Tl
77 v kD a—/s3w 73 TREEVIEW Callback () T3,

5.4 GUI-Builder
emWin IZ1Z GUI-Builder &\\5 Y — A& ENTNT, emWin 71 V= v F s TS T 7 4 IS
2P =T 2 A RAEERTH N TEET,

demo2_dialog2.c 7 7 A L OH > 7 a— Rix, GUI-Builder IZ X > TAEREN=X AT RYy 7 AD
M GEEZRLTOVET, 2OV —L2HHTL5E, Vs Fufbshica—Y—A 2 F =T = ZAD
ERRAEELIZ 720 908, ARSI a— REZOFEHHTE S LIIRY THA,

demo2_dialog2.c 7 7 A MiZEHEND Y —A =3 — RiX, GUI-Builder Y — iz k> THEKSNE L, T
FEELATOEOICMERT— NIT T, TiOa Ay FTHELNEBIGEN ST ET,

/I USER START (Optionally insert .. . .)
)/.l.JSER END
P TME, Tv—b U 4 Ry T TFRR BROR2OORZ UREENALTHET, o7 iz

I~ AATINH Y FHADT ARY AL TEBL T BT 74V hOR KX o a— R THEE S i,
WM_POST PAINT A vt —UHICH A TR T a— Ny 7 —F Nk 5> THERSNET,

55 EwbreyTOER
Ey b~y 72—l —RKT537 7 AV ATARRTE, BB EER L CCEOES| L
LTCE—T79A0ERHY FT,
A A= T 7 A NESCFRINIEBRT A2 2 DOHFERBY £3, WFOFEICITHEE FL— R
FI7MWHVFET, GENTWDEY T a—RiE, WMFOHFEEZEH LA A=W A2 L THET,

7'v =7 b c31_demo2 TlE, demo2_images.c D475 Bin2C.exe TIEESNE LTz, 7 7 A VNDK
WDA A—=V1E, BMP 7 7 A LD~y Z—IE#R, 0x42 (b) BLO0x4D (m) T, #& Y OEi{4IL.GIF
BN LHELNTZ DT, TSN A IS & .GIF A4 A — U OFEEII e 0x47, 0x49, 0x46
(GIF) BERENET,

71 Y= b ¢31_demo3 Tix. epsonlogo.c 7 7 A /L? Epson 7 =A A— % BmpCwt 7’11 7' L% fifi
HALUTERLE L, 4 A—VESINOT =212, 77 A~y X—EFRITEENTOETA,

[Bin2C]

Bin2C.exe %, Segger #1:> Web ¥ K (https://www.segger.com/downloads/free_tools) 762 o m— K
ISSEXE

71 7Z 5 Bin2Cexe X, (EEDONRA TV 77 A NEXFOESINCERLE, 7u /I 052 EHL T
NAFVIERDA A—T 7 744 (BMP, JPG. .GIF, .PNG) % SCFEEFNCEWT 52 LN TEFT,

NAFT VA A=V DO LFHEHNA~DELZLBBOF)HIL, A A=V T 7 ANV ERUREE2RFFT52 T
HY, ARA—T T ANADBERESNTWBESITT A XL/ &L £3,
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5. S1C31 Family T emWin Z{#AY 2545 0# 21FH

ZOREIE, BEBREE LT A0 —F L B ETe LB Ko THBA SV E T, A rl b EHE 72w
Tx—<v s WZIXIPG 77 A/V) T, BEINEBOOE FRIND MO E —HIEDZ ENK
HHZ2 D £9,

Bin2C Z M L CTA A — T &2AEKT 2 HIEITLL T o@E ) T9,

1) 77V r—varalEEd,

File: | SamHhml
Correert About Cloze

X 5.1 Bin2C 2EEmE

2) [Selectfile . JRhZ &2V w7 L, BMLI-WIT 7 AANDDHLT 4 L7 NI EBRL, 77 A V%
TIRLC[Open] R v &7V v 7 LET,

Select source file name

i v A » ThisPC » Desktop » epsonlogo v | D Search epsonlogo 2
Organize - Mew folder =~ [ O
~
EH This PC
I Desktop

2016 Dec Marketing Reg

EPSON

emWin EXCEED YOUR YESION

emWin_sample epsonlogo.brmp

epsonlogo

FSA Holding Area

MCU Stuff

Metwork Infomation
Metwork_Documentatic
s1c31d0Mo0

Spiders v

File name: |epsc|-n|c|-gc|-.bmp V| All files (%) il

Open |"r Cancel

E52 Z7A4IERSA7OY
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3) “Convert” "& %27 Vv THE, 77ANDASCHREANBAALFT VA A=V ERLT 4 L7 b
VIZRIFENET,

File: |E: WUzers\BobE WD C\Deszktop\epzonlogohep Select file... |

Corrvert l: About Cloze

X 53 EBRE#RA4T7TOY
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[BmpCvt]

BmpCvtexe TIER Sz I1X, 77—/ XL v b EEBOX YT L2 RITMEOES| THERK S L Tun
F4, ZOLIIC L TERESNZEEIL, Bin2Cexe TEMR SNZEHZ LY HbFhickEWVHs L
FHAN, BT a— FL—F NI Bl a— FARX—X 372 BEOT a— R4 —/—~vy K372
W2 B DFEAIAFEE RRRE S 72 0 £,

emWin 7 7 U r—v 2 L THIT A By b~ v 7o A=V B ERT B I FO@ Y T,
1) FF. AA—VEERL, AEESLEZEAHY 8 By MWD LET,
EPSON’

EXCEED YOUR VISION

“¥SxC31xx-emWin_ver_x_xx ¥emWin¥Sample¥c31_demo3¥artwork” 7 1 L7 k U 24 % epsonlogo.bmp %
ZHLTEEN,

2) 7mZZ L. BmpCvtexe ZEEEIL, £ A—T%BmpCwvt 7 4 > RDUIZRT v 7 LET,

o Bitmap Converter for emWin V5.32 - C\Users\BobE VDC\Desktop\epsonlogo.bmp

File Edit View Image Options Help
Resolution: 100 * 32

Colors: 255 |INENTIEE NEEN W TRENEN BTN e em e rme e aamm o
Zoom: 1.0*%
Transparent —

EPSON

EXCEED YOUR VISION

Image calculation done

54 AA—=T 774 ILEHRAH
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3) [Image]> [Convert to] >[6bit color (222)] ZfEHI L CTA A — % 6 By b T —IZAEH L £,
et Bitmap Converter for emWin ¥5.32 - C:\Users\BobE.VDC\Desktop\epsonlogo.bmp

File Edit View Image Options Help

Resolution: 10 Transparency... |

Colors: 251 o a—— T TR T TTT T T T |

0om: .

Transparent — Dither to ] Grayd (2 BPP)
EPSON Flip b Gray16 (4 BPF)
EXCEED YOUR VISION Rotate > Graybd (8 BPP)

Invert > Gray236 (8 BPP)
Shrink b 3 bit Coler 111 (4 BPF)
Reduce Colors ] 6 bit Color 222 L\S. (8 BPP)
Scale.. 8 bit Coler 233 (3 BPP)
8 bit Coler 323 (8 BPP)
iz 8 bit Color 332 (2 BPP)
8 bit Color 3666 (3 BPP)
12 bit Color 444 (16 BPP)
16 bit Color 535 (32k colors)
16 bit Color 565 (64k colors)
RGE (24 BPP)
Best palette
Best palette + transparency
Custom palette...

Convert image to 222 (64 colors).

5.5 A A—SBIRMHE

4)

[File]>[Save as...] &8RN L T, Bifpz CFESI & L TE—7 LET,

g | Bitmap Converter for emWin V5.32 - C\Users\BobE VD C\Desktop\epsonlogo.bmp

File

Edit View Image Options Help
Open..

1 C\Users\BobE VD C\Desktop'epsonlogo.bmp

2 Ch\Users\BobEVDC\Desktop\logo.bmp

3 Ch\Users\BobE VD C\Desktop\Demo Artwork\epsonlogo.bmp
4 C:\Users\BobEVDC\Desktop\Demo Artwork\logo.bmp

3 C:\Users\BobE VDC\Desktop\Final Artwork\canadaflag.brmp
6 C\Users\BobE VD C\Desktop'\Final Artworki.canadaflag.gif

7 C:\Users\BobEVDC\Desktop\Demo Artwork\done\bg.png

8 Ci\Users\BobEVDC\Desktop\tmp\printercommercial2.gif

Create Alpha...
Load Alpha mask...

Create animated sprite from GIF...

Create animated cursor from GIF...
Save palette...

Exit

Ctrl+0Q

Save as (Select from different file types).

5.6 A A—RTFIRIE
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5) “Saveastype:” & “"C"Ev hvyTTrA (*0)” IZREL. BIDT 7 A IVIAEE DA
AT ET, [Save]lRZ &7V v 7 LCHitg7 v A vet—7LET,

Emp

oot oave bitmap file

Save in:l epsonlogo j - rj( B~ %

Mo items match your search,

Iepsonlogo c Save

Cancel

il

3ll|"C" bitmap file [".c)

5.7 A A—UREFEAE REAXER

56 BFEDemWinHd>rFILa—KDER

Segger 11X, emWin GUI OV 7 va— ROREDOa L7 va il TnET, 1FEAEDH
Y a— RiE S1C31D01 7T » R 7+ — A TEWEL 97, GiROCAENRUBIIRDLA60H0 F
7T

Segger fEDH > 7L — K%, Windows X—ADT I 2 L —F THEATL-OIER SN TVWES, =
TS XD By A— 3=~y RGBS, S1C31D0L TE T 2 72 DICIZHIBR T 2 LER H  £77,
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